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The Agilent OpenLAB CDS Software 7

Before You Begin 8

This chapter gives you an overview of the OpenLAB software. It also includes 
certain requirements before starting the installation. 
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1 Introduction
Who Should Read This Guide?
Who Should Read This Guide?

This installation guide is designed to help system administrators install the 
Agilent OpenLAB Chromatography Data System (CDS) to networked 
workstations quickly and correctly. 

See your Agilent representative for other system configuration installation 
guides.

Figure 1 Networked Workstation Configuration
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The Agilent OpenLAB CDS Software
The Agilent OpenLAB CDS Software

The Agilent OpenLAB CDS, along with OpenLAB Electronic Lab Notebook 
(ELN), OpenLAB Enterprise Content Manager (ECM), and OpenLAB Data 
Store plus several add-ons make up the Agilent OpenLAB software suite. 

These integrated solutions form a system designed to grow with customers' 
needs, from a small standalone analytical lab to a global network with 
hundreds of locations. Using the OpenLAB software, instruments from 
multiple vendors can connect to any size network — from individual 
workstations and workgroups to global enterprises. With full instrument 
control, centralized administration and ease-of-support, users can achieve 
lower operational costs and better instrument use. See your Agilent 
representative to learn how other products in the OpenLAB suite can help 
you.

The Agilent OpenLAB CDS software is provided on several edition-specific 
disks. Table 1 lists the disks you will receive for your software edition.

Table 1 OpenLAB CDS Components

Disk Name ChemStation Edition EZChrom Edition

OpenLAB CDS Shared Services Software X X

OpenLAB CDS ChemStation Edition Core 
Software

X

OpenLAB CDS ChemStation Edition Drivers X

OpenLAB CDS EZChrom Edition Core 
Software

X

OpenLAB CDS EZChrom Edition Drivers X

OpenLAB CDS Support X X

OpenLAB CDS Data Store Software X X

OpenLAB Data Analysis X X
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1 Introduction
Before You Begin
Before You Begin

To simplify installation of the software, it is helpful to decide on some 
configuration options before you begin the actual software installation.

1 For installing OpenLAB CDS, you need to have administrator privileges for 
all servers and clients. Power user privileges are not sufficient (the 
installation does not start).

2 Decide on a Shared Services server and a directory location to store all files 
related to the data system software, including data, methods, sequences, 
and configurations.

• CDS clients must be connected via network to the Shared Services 
server.

• If you plan to use the OpenLAB ECM, CDS client users must have 
read/write access to the ECM directory location.

3 If you are installing OpenLAB CDS EZChrom Edition, create an Enterprise 
path folder on the file server, with a share status Everyone > Full permissions. 
Because the system must access this folder as a uniform naming 
convention (UNC) share path, it must be created prior to actual 
installation. UNC paths define the common syntax pattern for share folder 
location and retrieval.

4 For the Shared Services Database server, obtain the:

• Database name

• Database administrator user name and password

• Authentication mode

• Administrator user credentials (domain, user name, password)

5 If you plan to use OpenLAB ECM with your system, obtain the ECM server 
name.

6 If you plan to use the Oracle DB server, make sure to set up the Oracle DB 
following the description in CDS_oracle11.pdf on Disk1/docs/enu.
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Before You Begin
7 Decide on the software delivery approach you want to use:

• Install directly from the DVDs to your computer — Load the disks as 
required directly to the workstation disk drive.

• Copy DVDs to a centralized location for installation — You can use the 
utility to copy DVD content to a network share folder or USB drive, and 
run an uninterrupted installation from that location. This approach will 
save time; when you install from the folder, you won’t have to reload the 
disks.

8 Remember that when you launch the application, you will be able to review 
the following PDFs in the installer Planning and Resources menus before you 
install the software:

Under the Installer Planning menu, you will find:

• Hardware and Software Requirements (CDS_hwsw- requirements.pdf) - Use 
this PDF to determine whether your hardware and software will support 
the system.

• Networked Workstation Installation Guide: 
(CDS_networkedWS-Installation.pdf) - An electronic copy of this installation 
guide is provided in PDF format for your convenience.

Under the Installer Resources menu, you will find:

• OpenLAB CDS Network Requirements - Use this PDF to check that your 
settings comply with the network requirements.

9 Set up your networked environment for the Shared Services server and all 
workstations:

• If you are installing OpenLAB CDS to Windows Server 2008 R2, Windows 
7 or Windows Vista, go to the Windows Control Panel and switch off User 
Account Controls. After installation is complete, you can switch the 
controls back on.

• Windows Server 2008 R2 users — go to Server Manager > Features > Add 
Features, then select and activate .NET Framework 3.5 SP1.

10 Set up the necessary power, equipment and hardware connections to run 
your system, including any A/D boards, cables, GPIB boards, instrument 
detectors, and communication cables.
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Configuration of 
Windows Server 2008 R2

Install Windows Server 2008 R2 12

Configure Windows Server 2008 R2 Settings 13

This chapter describes the necessary installation and configuration steps to 
prepare an OpenLAB Shared Services server.
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2 Configuration of Windows Server 2008 R2
Install Windows Server 2008 R2
Install Windows Server 2008 R2

1 Install Windows Server 2008 R2 from recovery DVD or Windows Server 
2008 R2 DVD. During the setup of Windows Server 2008 R2 provide the 
computer name, administrator password and network settings.

2 Select to either join an existing domain or set up the system in workgroup 
mode.

3 To guard your systems against viruses, install an AntiVirus program. 
Running AntiVirus programs might influence the behavior and 
performance of your computer. Agilent OpenLAB CDS was tested to run 
with Symantec's Norton Antivirus.

4 If you plan to use OpenLAB Data Store: 

• Install Microsoft SQL Server 2008 R2 SP1 Standard or Enterprise in 
Mixed Mode on the server. For more information on changing the mode 
for an existing installation, see “Change Server Authentication to Mixed 
Mode” on page 68.

• When installing Microsoft SQL Server 2008 R2, do not select the Reporting 
Services feature. These services use port 80 and will conflict with the 
OpenLAB Data Store web server.

CAUTION Insufficient virus protection

Your PC might get infected.

➔ Keep your computer disconnected from the internet until you have installed the 
appropriate security patches and hot fixes.

➔ It is strongly recommended to install the latest security fixes as supported from 
Agilent Technologies and virus definitions prior to connecting to a network.

NOTE If you plan to use OpenLAB Data Store: Install SP1. You can download the service pack from 
the Microsoft web page (http://support.microsoft.com/kb/976932).

NOTE Do not install or configure any server role or feature.
12 CDS Networked Workstation Installation Guide
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Configure Windows Server 2008 R2 Settings
Configure Windows Server 2008 R2 Settings

Most changes in the following section are mandatory for A.01.04 to work 
properly on a Windows Server 2008 R2 system. Some changes will optimize 
application performance. Other changes will have a graphical or minor impact.

[MUST] 1 Folder Options (right-click Start > Open Windows Explorer):

a Choose Organize > Layout.

• Enable Menu Bar.

• Enable Navigation Panel.

b Set View to Details.

c Choose Tools > Folder Options > View tab.

• Disable the option Hide extensions for known file types.

• Enable the option Display the full path in the title bar (Classic theme only).

d Apply these settings to all folders by selecting the Apply to Folders button.

[MUST] 2 Go to Start > Control Panel > Windows Update. Check for updates and apply all 
critical security patches.

3 Install additional hotfixes:

• Always install hotfix KB2600907 
(http://support.microsoft.com/kb/2600907).

• If you plan to use OpenLAB Data Store: Install hotfix KB2577795 
(http://support.microsoft.com/kb/2577795).

NOTE To indicate the relative importance of individual settings, each item is categorized as:

• MUST: These changes must be applied.

• PERFORMANCE: These changes will improve system performance.

• OPTIONAL: Most of these changes will affect the graphical display of the application.

NOTE If User Account Control (UAC) is switched on, some configuration steps will require active 
confirmation to continue.
CDS Networked Workstation Installation Guide 13



2 Configuration of Windows Server 2008 R2
Configure Windows Server 2008 R2 Settings
[MUST] 4 Register Windows Server 2008 R2 with Microsoft.

[MUST] 5 Select Change Settings. Set the Important updates selection to Never check for 
updates. Deselect the other update options.

Close the Update screen.

[MUST] 6 Go to Start > Control Panel > Administrative Tools. Select Services.

a Right click on the Desktop Window Manager Session Manager service. In the 
context menu select Properties.

• Set the startup type to Disabled.

b Right-click on the Application Experience service. In the context menu, 
select Properties.

• Set the startup type to Disabled.

Confirm by clicking OK and close the Services window. Close Administrative 
Tools.

[MUST] 7 Power Options: Start > Control Panel > Change options that are currently 
unavailable > Power Options.

a Enable power plan High performance (Show additional plans).

b Click Change Plan settings.

c Click Change advanced power settings.

• Open the nodes for Hard disk, Turn off hard disk after and check that 
Minutes are set to 0 (=Never).

• Click OK.

d Save the changes.

[MUST] 8 Local Security Policy: (Start > Control Panel > Administrative Tools > Local 
Security Policy)

a Navigate to Security Settings > Local Policies > Security Options.

b Double-click the following policy listed in the right hand panel: Network 
Access: Sharing and security model for local accounts.

c In the displayed dialog select the following item from the drop-down list: 
Classical - local users authenticate as themselves.
14 CDS Networked Workstation Installation Guide
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Configure Windows Server 2008 R2 Settings
[MUST] 9 Region and Language Options (Start > Control Panel > Regional and Language 
Options):

a Regional options should be set to English (United States) from the 
drop-down list.

b If regional format other than English (United States) is used, the following 
settings are mandatory. The settings can be defined by clicking the 
Customize this format button:

• Decimal symbol = . (point)

• Digit grouping symbol = , (comma)

• List separator = , (comma)

c Language for non-Unicode programs:

• On the Administrative tab click Change system locale....

• From the drop-down list, select English (United States).

[MUST] 10 Power Management for network devices (From Start > Control Panel > 
Network and Sharing Center):

a Select Change adapter settings. Click Local Area Connection > Properties > 
Configure).

b On the Power Management tab, uncheck all items.

[MUST] 11 Screen layout (right-click on Start > Control Panel > Display):

a Click on Change color scheme.

b Check that Windows Classic is selected.

[PERFORMANCE] 12 System Properties: Start > Control Panel > System: click Advanced system 
settings.

a On the Advanced tab > Performance hit the Settings button.

• Visual Effects tab, uncheck all entries.

• Advanced tab > Virtual Memory: For optimum performance use the 
Change button to adjust the paging file size to a value of 2 to 3 times of 
the physical RAM on the PC.

• Data Execution Prevention tab: Enable Turn on DEP for essential Windows 
programs and services only.
CDS Networked Workstation Installation Guide 15



2 Configuration of Windows Server 2008 R2
Configure Windows Server 2008 R2 Settings
b Advanced > Startup and Recovery > Settings button:

• System startup section: Change both Time to display ... fields from 30 to 3 
sec.

c Remote tab

• In the Remote Assistance section, uncheck Allow Remote Assistance 
connections to this computer.

[OPTIONAL] 13 Welcome Center (Start > search for 'gpedit.msc')

• Navigate to Local Computer Policy > Computer Configuration > Administrative 
Templates > System > Logon.

• Enable Don't display the Getting Started welcome screen at logon.

[OPTIONAL] 14 Recycle Bin Properties: (right-click on desktop icon Recycle Bin). Enable 
the following options:

• Custom size; select a size corresponding to approximately 10% of the 
complete disk space for the drive.

• Check Display delete confirmation dialog.

[OPTIONAL] 15 Apply the Security Settings suggested by Microsoft at: 
http://technet.microsoft.com/en-us/library/cc264467.aspx
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The installation is automated for you by the included OpenLAB CDS Master 
Installer. This tool installs the various components of OpenLAB CDS. OpenLAB 
Data Analysis can also be installed as add-on version.
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3 Install the Software
Step 1: Run the Application
Step 1: Run the Application

1 For the direct DVD approach, insert the OpenLAB CDS Installation disk. 
Autorun.inf will automatically run Agilent. OpenLABCDSSetupFromDVD.exe 
and display the installer Planning screen.

2 For the portable data storage device approach, insert the device in a 
computer USB port, navigate to \Disk1\Setup.bat and run the application to 
proceed to the Planning screen.

3 For the share file approach, first map the drive, as the installation from a 
UNC path is not supported. Use Setup.bat under \Disk 1 and run the 
application to proceed to the Planning screen.
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Install the Software 3
Step 2: Copy DVDs to a Centralized Folder for Installation (Optional)
Step 2: Copy DVDs to a Centralized Folder for Installation 
(Optional)

Completing this step will enable you to run an uninterrupted installation 
directly from a folder—i.e., you will not have to load individual disks during 
actual installation.

1 From the Master Installer Planning screen, select Installation from the sidebar 
menu.

2 Select Preparation of an Installation from Network Share.

3 At the Network Share screen, browse to a directory and create a destination 
folder as follows:

a Select the button with the three dots.

b Navigate to the directory where you want to create the folder (you can 
navigate to a USB drive port to create the folder on a USB drive).

c Select Make New Folder.

d Type in the folder name.

e Select OK. The system will return you to the Network Share screen, with 
the path displayed.

f Select the disks you want to copy to the folder: All disks, ChemStation disks, 
EZChrom disks, or OpenLAB Data Analysis disks.

g Select Start.

h Follow the prompts to insert new disks as they appear.

4 When processing is complete, copy the files to the local drive or map the 
location to a network drive.

5 Close the application and navigate to the directory and folder you created. 
Open the folder.

6 Select the Disk 1 folder, then execute Setup.bat to run the application.

The system will display the installer Planning screen.

NOTE Installations into the root of a drive may cause problems during operations and are not 
supported.
CDS Networked Workstation Installation Guide 19



3 Install the Software
Step 3: Run the System Configuration Checker
Step 3: Run the System Configuration Checker

1 At the Planning screen, select System Configuration Checker. If .NET 3.5 SP1 or 
higher is not on your system, the Agilent OpenLAB CDS Prerequisites Setup 
Screen appears.

a Read the licensing agreement.

b Select Accept to accept the agreement and begin .NET 3.5 SP1 
installation.

2 For the server configuration check, select OpenLAB CDS Shared Server Core 
A.01.XX from the drop-down list.

3 For each workstation, select from the drop-down list the edition of the 
OpenLAB CDS software you are installing:

• OpenLAB CDS EZChrom Edition A.04.XX

• OpenLAB CDS ChemStation Edition C.01.XX

• OpenLAB Data Analysis A.01.XX

4 Select OK.

5 Complete page 1 of the Contact Information—System details by typing in the 
fields provided.

• System Location fields

• System Information fields

• Configuration fields

6 Review the system details and make any necessary entries. The system will 
follow the paths specified.

NOTE If you select Don't Accept at this screen, the install program will exit. You will have to 
install .NET 3.5 SP1 or higher manually to proceed with OpenLAB CDS installation.

NOTE The regional settings must be configured to use the dot ('.') as a decimal separator.
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Step 3: Run the System Configuration Checker
7 Select the green check-mark icon in the top left corner of the screen to 
begin the software check. A summary report is displayed showing the 
results for each check category. Results are expressed as Pass, Warning, 
Critical Warning, or Fail. 

Fail results must be corrected before continuing with the installation. 
Agilent recommends investigating and correcting any Critical Warnings and 
Warnings whenever possible before proceeding.

8 To view details of the report, select the appropriate link: System Hardware 
Details, Operating System and Software Details, or Manual Verification Required.

9 To save the report, select the Save icon at the top left of the screen.

10 E-mail the saved report to your Agilent Service Representative for 
evaluation, and for validation of your personal computer for Agilent 
Software Systems Installs.
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3 Install the Software
Step 4: Run the OpenLAB CDS Installation Wizard on Shared Services Server
Step 4: Run the OpenLAB CDS Installation Wizard on Shared 
Services Server

At this point, you will be installing to the Shared Services server either 
directly from the DVDs or from a local drive (mapped to either USB/eSATA 
drive or a network location). The installation steps are identical until you start 
the installation wizard: you won’t be prompted to load the DVDs if you are 
installing from a centralized location.

License Agreement Screen

1 If you will be using a local database for the server, you must have Windows 
Installer 4.5 installed. To install it from the Installation screen:

a Select Third Party Tools and then Windows Installer 4.5.

b Read the licensing agreement.

c Select Accept to accept the agreement and begin Windows Installer 4.5 
installation.

d When installation is complete, click OK to return to the Installation screen.

2 Select OpenLAB CDS.

3 If your Shared Services server is running under Windows 2003 Server R2 
and if .NET 3.5 SP1 is not on your system, the Agilent OpenLAB CDS 
Prerequisites Setup Screen appears.

a Read the licensing agreement.

b Select Accept to accept the agreement and begin .NET 3.5 SP1 
installation.

NOTE Follow this procedure only for first time installation on the Shared Services server. Skip this 
step if the server is already set up.
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Step 4: Run the OpenLAB CDS Installation Wizard on Shared Services Server
If your Shared Services server is running under Windows 2008 Server R2, 
.NET 3.5 SP1 will be installed automatically.

4 The OpenLAB CDS Installation Wizard opens. Read the terms of the License 
Agreement. Master Installer provides a printable PDF of the license 
agreement under the Resources option of the main menu.

5 Select I agree with the terms and conditions. You cannot proceed with 
installation unless you agree to these terms.

6 Select Next to proceed to the Installation Folder screen.

Installation Folder Screen

1 Type the folder name or browse to the directory where you want to store 
the application components.

2 To run an installation qualification as part of this Shared Services server 
installation, select Run Installation Qualification.

Because there can be several separate installation procedures for 
networked systems, you may prefer to run the IQ during the last 
installation, or sometime after your system is completely installed (see the 
Optional Procedures in this manual).

3 Select Next to proceed to the Installation type screen.

NOTE If you select Don't Accept at this screen, the install program will exit. You will have to 
install .NET 3.5 SP1 or higher at a later time to proceed with OpenLAB CDS installation.

NOTE Installations into the root of a drive may cause problems during operation and are not 
supported.
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3 Install the Software
Step 4: Run the OpenLAB CDS Installation Wizard on Shared Services Server
Installation Type Screens for Shared Services Server

Follow this procedure to install the OpenLAB Shared Services server without 
Data Store. To install the Data Store server, skip this step and continue with 
“Installation Type Screens for Data Store Server” on page 27.

1 Under the Installation type screen, select Networked System.

2 Select Next to proceed to the Networked system screen.

3 Select Shared Services Server.

4 Select Next.

5 Complete the Database type screen by selecting either New SQL Server 
installation, Existing SQL Server or Existing Oracle Server.

The New SQL Server installation option requires Windows Installer 4.5, as 
described in the License Agreement Screen steps above.

6 Configure the database as described in the following steps.

7 If you selected New SQL Server installation:

a Type the path or browse to the directory where you want to store the 
application components. Directory names must be entered without 
spaces.

b Select Next.

c Complete the Database name field.

d Select the authentication mode.

e Select Next to proceed to the Additional items, Language, and Register 
applications screens.

8 If you selected Existing SQL Server:

a Type the database server name in the field provided.

b Select Use default instance or Use named instance.

If you select Use named instance, complete the Database instance name field.

c Select Next.

NOTE If you select the Use SQL server authentication mode, complete the DB user name, DB 
user password, Administrator name, and Administrator password fields.
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Step 4: Run the OpenLAB CDS Installation Wizard on Shared Services Server
d Complete the Server connection type screen. Select either Create new 
database or Connect to existing database. If you select Connect to existing 
database:

• Enter the Database name in the field provided.

• Select the authentication mode. If you select the  Use SQL server 
authentication mode, complete the DB user name, DB user password, 
Administrator name, and Administrator password fields.

• Click Test Connection... to run a connectivity check. The system will 
verify that the connection from this machine to the SQL server is 
functioning.

The system will display a Connection succeeded message if the check is 
successful. Click OK to close the message.

e Select Next. If you entered Connect to existing database in the previous step, 
the system will proceed to the Additional items screen. If you selected 
Create New Database in the previous step, the system will display an 
OpenLAB Shared Services database screen.

• Enter the Database name in the field provided.

• Select the authentication mode. If you select the Use SQL server 
authentication mode, complete the DB user name, Database user password, 
Administrator name, and Administrator password fields.

• Select Next to proceed to the Additional items screen.

9 If you selected Existing Oracle Server:

a Enter the Database server name in the field provided.

b Select Next.

c In the Server connection type screen, select the Initialize data check box if 
you want to write configuration data, like standard permissions and 
roles, into the database.

d Enter the Database name and the Database user name in the field provided.

The database user name is the administrator name that was defined 
during the Oracle Server installation.

e Enter the Database administrator password.

f Check the Listener port number. By default, it is set to 1521.

g Click Test Connection... to run a connectivity check. The system will verify 
that the connection from this machine to the Oracle server is 
functioning.
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Step 4: Run the OpenLAB CDS Installation Wizard on Shared Services Server
The system will display a Connection succeeded message if the check is 
successful. Click OK to close the message.

10 If you want to use OpenLAB ECM with your data system:

a Check the ECM Server option button. The system will activate a Server 
name field.

b Enter the server name without spaces.

c Click Test Connection... to run a connectivity check. The system will verify 
that the connection from this machine to the ECM server is functioning.

The system will display a Connection succeeded message if the check is 
successful. Click OK to close the message.

11 Under OpenLAB Shared Services Language, select the correct language from 
the drop-down list.

12 Under Register applications, check the edition that applies. If you check the 
EZChrom Edition, the system will activate an Enterprise path field. This is the 
UNC path you created in the Before you Begin steps. Type in the path 
name, or browse to the directory. Path names must be entered without any 
spaces.

13 Select Next to proceed to the Summary screen.
26 CDS Networked Workstation Installation Guide



Install the Software 3
Step 4: Run the OpenLAB CDS Installation Wizard on Shared Services Server
Installation Type Screens for Data Store Server

1 Under the Installation type screen, select Networked System.

2 Select Next to proceed to the Networked system screen.

3 Select Data Store Server.

4 Select Next to proceed to the Database type screen.

5 Type the database server name in the field provided.

6 Select Use default instance or Use named instance.

If you select Use named instance, complete the Database instance name field.

7 Select Next.

8 Complete the Server connection type screen. Select either Create new database 
or Connect to existing database. If you select Connect to existing database:

a Enter the Database name in the field provided.

b Select the authentication mode. If you select the  Use SQL server 
authentication mode, complete the DB user name, DB user password, 
Administrator name, and Administrator password fields.

c Click Test Connection... to run a connectivity check. The system will verify 
that the connection from this machine to the SQL server is functioning.

The system will display a Connection succeeded message if the check is 
successful. Click OK to close the message.

9 Select Next.

10 If you entered Connect to existing database in the previous step, the system 
will proceed to the Additional items screen. If you selected Create New 
Database in the previous step, the system will display an OpenLAB Shared 
Services database screen.

a Enter the Database name in the field provided.

b Select the authentication mode. If you select the Use SQL server 
authentication mode, complete the DB user name, DB user password, and 
Administrator password fields.

11 Select Next to proceed to the Additional items screen.

Preparations • Microsoft SQL Server 2008 R2 Standard or Enterprise must be installed in Mixed Mode on the 
server.

• Port 80 must be open for OpenLAB Data Store to function correctly.
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12 In the Content files directory field, enter a suitable location to upload all data 
from OpenLAB CDS applications.

This location will hold the content files for OpenLAB Data Store. Therefore, 
the location must be on a disk that has plenty of storage space.

13 Under OpenLAB Shared Services Language, select the correct language from 
the drop-down list.

14 Under Register applications, check the edition that applies. If you check the 
EZChrom Edition, the system will activate an Enterprise path field. This is the 
UNC path you created in the Before you Begin steps. Type in the path 
name, or browse to the directory. Path names must be entered without any 
spaces.

15 Select Next to proceed to the Summary screen.

Summary Screen: Server Software Installation

1 Review the installation settings that you have selected in the preceding 
steps. Select Back as necessary to change installation settings, or Cancel to 
cancel the installation.

2 Select Start to begin installation.

The system performs an automated system check before it proceeds with 
the listed activities.

If a system check passed message appears, installation continues.

If a system check failed message appears, you can either:

• Decline to view the system report, and continue installation.

• View the system report, and decide to continue installation.

NOTE Before starting or canceling the installation, you can save an XML file with your installation 
settings. This XML can then be used for a scripted installation (see “About Scripted 
Installation” on page 50).
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• View the system report and postpone installation until the problem is 
fixed.

• Decline to view the system report and postpone.

3 Your installation settings determine which disks need to be copied during 
installation. If you are installing directly from the DVDs, follow the Insert 
Disk prompts as they appear.

If you are installing from a local drive, you won’t insert disks or browse to 
disk folders — the entire installation will run automatically, based on your 
installation settings.

If the OpenLAB CDS Installation Wizard cannot locate a necessary file (whether 
on a disk or in a folder), a Disk or File not found prompt will appear.

For disks, follow the prompts to:

• Retry using the same disk.

• Insert the correct disk (if you made an error), and select OK.

• Select Cancel to cancel the installation. The system will uninstall any 
components installed so far.

If a file in a centralized folder cannot be found, you may have to recreate the 
folder. See “Step 2: Copy DVDs to a Centralized Folder for Installation 
(Optional)” on page 19 above.

If the installation of any vital application or component fails, the 
installation will roll back (uninstall). If a failed component can be installed 
at a later time without affecting basic installation (e.g. ECM API, Driver) the 
installation will proceed. In this case you will be notified of any failure(s), 
and that further steps are necessary to fully complete installation.

4 If an IQ was completed as part of this installation, review the Installation 
Qualification Report. If the report indicates failure, verify the computer 
requirements and reinstall the data system. Do not use the system until an 
Installation Qualification Report gives a ‘pass’ result.

5 Click Finish to close the installation wizard.

6 Reboot the server after the installation.

NOTE To view the system report as PDF file, Adobe Reader must be installed.
CDS Networked Workstation Installation Guide 29



3 Install the Software
Step 5: Set up OpenLAB CDS Administration
Step 5: Set up OpenLAB CDS Administration

1 From the Shared Services server, open OpenLAB CDS from the OpenLAB 
CDS Control Panel shortcut on the desktop or go to Start > All Programs > 
Agilent Technologies > OpenLAB > OpenLAB Control Panel.

2 From the navigation pane, select Administration > System Configuration.

3 In the System Configuration toolbar, select Edit System Settings.

4 In the Edit System Settings window, select your authentication provider from 
the drop-down list.

If you installed a Data Store server, you can only choose between Internal, 
Windows Local, or Windows Domain.

5 Select your storage provider from the drop-down list.

The storage type Data Store is available only if Data Store has been deployed.

6 Select Next.

7 Select a user to administrate the system.

a If you selected Internal as an authentication provider:

• Select Create Account.

• In the Create Administrator Account dialog box, enter a Name and a 
Password.

b If you selected Windows Local as an authentication provider:

• Select Select Account.

• Enter a search string.

• In the Search Users dialog box, select Search to view a list of users.

• Select a user.

c If you selected Windows Domain as an authentication provider:

• Select the check box to activate the input fields.

• Enter a Domain, User, and Password.

• Select Select Account.

• Enter a search string.
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• In the Search Users dialog box, select Search to view a list of users.

• Select a user.

d If you selected ECM as an authentication provider:

• Provide the ECM Server URL and enter the ECM user credentials.

• Select Select Account.

• Enter a search string.

• In the Search Users dialog box, select Search to view a list of users.

• Select a user.

8 Select OK.

9 If you selected Data Store as the storage provider: Activate Data Store.

a Enter the URL of the Data Store server (http://<server name>).

b Enter the credentials required for activation.

c Click Activate.

A success message is shown. Click OK to confirm.

If activation fails:

• Verify URL and credentials.

• Restart the AlfrescoTomcat service.

• Check the firewall.

• Check for port conflicts. Port 80 must be open.

10 Select Next.

11 Review your settings and select Apply.
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Step 6: Run the OpenLAB CDS Installation Wizard on a 
Networked Workstation

Use these procedures to install the software to any number of workstations 
linked to the Shared Services server. Each workstation may use different 
editions of OpenLAB CDS.

Here again you will be running your installation(s) either using the DVDs 
directly, or from a centralized folder. The installation steps are identical until 
you start the installation wizard: you won’t be prompted to load the DVDs if 
you are installing from a centralized location.

License Agreement Screen

1 From the OpenLAB CDS Master Installer screen, select Installation.

2 If you want to install OpenLAB Data Analysis, .NET Framework 4.0 must be 
installed on your system.

a Select Third Party Tools and then .Net Framework 4.0.

b The .NET Framework 4 Setup window opens. Accept the license terms to 
continue.

Click Install to continue.

c If .NET 4.0 was successfully installed, click Finish to return to the 
Installation screen.

3 Select OpenLAB CDS.

4 If .NET 3.5 SP1 or higher is not on your system, the Agilent OpenLAB CDS 
Prerequisites Setup Screen appears.

a Read the licensing agreement.

b Select Accept to accept the agreement and begin .NET 3.5 SP1 
installation.

NOTE If you select Don't Accept at this screen, the install program will exit. You will have to 
install .NET 3.5 SP1 or higher at a later time to proceed with OpenLAB CDS installation.
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5 The OpenLAB CDS Installation Wizard opens. Read the terms of the License 
Agreement. Master Installer provides a printable PDF of the license 
agreement under the Resources option of the main menu.

6 Select I agree with the terms and conditions. You cannot proceed with 
installation unless you agree to these terms.

7 Select Next to proceed to the Installation Folder screen.

Installation Folder Screen

1 Type the folder name or browse to the directory where you want to store 
the application components.

2 To run an installation qualification as part of this installation, select Run 
Installation Qualification. The Installation Qualification (IQ) provides 
documentary evidence that your system has been built and installed 
correctly, and that all design specifications have been met. You can run the 
IQ at a later time if you prefer (see “Run the IQ After Software 
Installation” on page 60).

3 Select Next to proceed to the Installation type screen.

Installation Type Screens

1 Under the Installation type screen, select Networked System.

2 Select Next to proceed to the Networked system screen.

3 Select Networked Workstation and hit Next.

4 Complete the Networked workstation component screen by selecting the CDS 
edition you want to install.

5 Select Next.

NOTE Installations into the root of a drive may cause problems during operation and are not 
supported.
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6 If you chose the  OpenLAB ChemStation Edition:

a Complete the OpenLAB CDS ChemStation Edition screen.

b Under Installation folder, type the path or browse to the directory where 
you want to store the application components. Directory names must be 
entered without spaces.

c Select the Install OpenLAB Data Analysis check box if you want to install 
this application in addition to your CDS edition. OpenLAB Data Analysis 
can be installed as add-on version at a later time if you prefer (see 
“Optional: Install OpenLAB Data Analysis as Add-on or Standalone 
Application” on page 39).

d Select the Install IO Library check box if you want to install the Agilent IO 
library suite. The suite can be installed manually at a later time if you 
prefer.

e In the OpenLAB Shared Services Settings for Registration screen complete the 
Server name field.

f Choose the authentication service provider which you configured on the 
OpenLAB Shared Services server.

g Provide the corresponding user credentials (see “Step 5: Set up 
OpenLAB CDS Administration” on page 30).

h When you type in the Server name, the Test Connection... button will be 
activated. You can test connectivity for this server before completing the 
rest of this screen.

i Continue with step 8.

7 If you chose the OpenLAB EZChrom Edition:

a Select the Install OpenLAB Data Analysis check box if you want to install 
this application in addition to your CDS edition. OpenLAB Data Analysis 
can be installed as add-on version at a later time if you prefer (see 
“Optional: Install OpenLAB Data Analysis as Add-on or Standalone 
Application” on page 39).

NOTE OpenLAB Data Analysis is not supported for installations with central data storage.

NOTE OpenLAB Data Analysis is not supported for installations with central data storage.
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b Under OpenLAB CDS EZChrom Edition, select the Install print server check box 
if you want to install the OpenLAB CDS print server.

c Select Next.

d In the OpenLAB Shared Services Settings for Registration screen complete the 
Server name field.

e Choose the authentication service provider which you configured on the 
OpenLAB Shared Services server.

f When you type in the Server name, the Test Connection... button will be 
activated. You can test connectivity for this server before completing the 
rest of this screen.

8 Select Next. The system will perform a connectivity check for the server.

If the connectivity test fails, verify that the server name was entered 
correctly, without spaces, and select Next to run the test again. If the test is 
still unsuccessful, you can:

• Enter a new server and try another test.

• Call internal support for assistance if you cannot connect to a server.

When a connectivity test has run successfully, the system will proceed to 
the Additional items screen.

9 If you want to use OpenLAB ECM with your data system:

a Check the ECM Server option button. The system will activate a Server 
name field.

b Enter the server name without spaces.

c Click Test Connection... to run a connectivity check. The system will verify 
that the connection from this machine to the ECM server is functioning.

The system will display a Connection succeeded message if the check is 
successful. Click OK to close the message.

10 Select Next to proceed to the Summary screen.
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Summary Screen

1 Review the installation settings that you have selected in the preceding 
steps. Select Back as necessary to change installation settings, or Cancel to 
cancel the installation.

2 Select Start to begin installation.

The system performs an automated system check before it proceeds with 
the listed activities.

If a system check passed message appears, installation continues.

If a system check failed message appears, you can either:

• Decline to view the system report, and continue installation.

• View the system report, and decide to continue installation.

• View the system report and postpone installation until the problem is 
fixed.

• Decline to view the system report and postpone.

3 Your installation settings determine which disks need to be copied during 
installation. If you are installing directly from the DVDs, follow the Insert 
Disk prompts as they appear.

If you are installing from a local drive, you won’t insert disks or browse to 
disk folders — the entire installation will run automatically, based on your 
installation settings.

If the OpenLAB CDS Installation Wizard cannot locate a necessary file (whether 
on a disk or in a folder), a Disk or File not found prompt will appear.

NOTE Before starting or canceling the installation, you can save an XML file with your installation 
settings. This XML can then be used for a scripted installation (see “About Scripted 
Installation” on page 50).

NOTE To view the system report as PDF file, Adobe Reader must be installed.
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For disks, follow the prompts to:

• Retry using the same disk.

• Insert the correct disk (if you made an error), and select OK.

• Select Cancel to cancel the installation. The system will uninstall any 
components installed so far.

If a file in a centralized folder cannot be found, you may have to recreate the 
folder. See “Step 2: Copy DVDs to a Centralized Folder for Installation 
(Optional)” on page 19 above.

If the installation of any vital application or component fails, the 
installation will roll back (uninstall). If a failed component can be installed 
at a later time without affecting basic installation (e.g. ECM API, Driver) the 
installation will proceed. In this case you will be notified of any failure(s), 
and that further steps are necessary to fully complete installation.

4 If an IQ was completed as part of this installation, review the Installation 
Qualification Report. If the report indicates failure, verify the computer 
requirements and reinstall the data system. Do not use the system until an 
Installation Qualification Report gives a ‘pass’ result.

5 Click Finish to close the installation wizard.
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Optional: Install Acrobat Reader

In order to view site prep or administrative reports (such as system reports), 
or to use the new Report Viewer Feature (ChemStation Edition only) you need 
a PDF reader.

If a PDF reader is not installed on your system, you can install Adobe Reader 
version 10.1.0 from the OpenLAB CDS installation DVDs. It is available on 
disk6/Adobe Reader in 4 language versions (English, Japanese, Chinese and 
Portuguese).

Run the self-extracting exe-file of your choice and follow the instructions of 
the Adobe Reader X Setup wizard.
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Optional: Install OpenLAB Data Analysis as Add-on or Standalone 
Application

If you have not installed OpenLAB Data Analysis together with OpenLAB CDS 
installation, you can install OpenLAB Data Analysis as an add-on to OpenLAB 
CDS or as a standalone application. 

1 Run the Master Installer. 

2 From the Master Installer screen, select Installation.

3 OpenLAB Data Analysis requires .NET Framework 4.0 on your system. If 
this application is already installed on your PC, you will find Microsoft.NET 
Framework 4 components under Start > Control Panel > Programs > Programs 
and Features.

4 To install .NET Framework 4.0:

a Select Third Party Tools and then .Net Framework 4.0.

b The .NET Framework 4 Setup window opens. Accept the license terms to 
continue.

Click Install to continue.

c If .NET 4.0 was successfully installed, click Finish to return to the 
Installation screen.

5 Select OpenLAB Data Analysis.

6 The OpenLAB Data Analysis Installation Wizard opens. Read the terms of the 
License Agreement. The Master Installer provides a printable PDF of the 
license agreement under the Resources option of the main menu.

7 Select I agree with the terms and conditions. You cannot proceed with 
installation unless you agree to these terms.

8 Click Next to proceed to the Installation Folder screen.

NOTE OpenLAB Data Analysis is not supported for installations with central data storage.
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9 If you have installed OpenLAB CDS A.01.04 as a single or networked 
workstation on your PC, OpenLAB Data Analysis will be installed as an 
add-on.

a To run an installation qualification as part of this installation, select Run 
Installation Qualification. The Installation Qualification (IQ) provides 
documentary evidence that your system has been built and installed 
correctly. You can run the IQ at a later time if you prefer.

b Click Next to proceed to the Summary screen.

c Continue with step 11.

10 If you have not installed OpenLAB CDS on your PC, OpenLAB Data 
Analysis will be installed as a standalone application.

a The OpenLAB Data Analysis Installation Wizard opens. Read the terms of the 
License Agreement. The Master Installer provides a printable PDF of the 
license agreement under the Resources option of the main menu.

b Select I agree with the terms and conditions. You cannot proceed with 
installation unless you agree to these terms.

c Click Next to proceed to the Installation Folder screen.

d You can use the default folder, type a new folder name or browse to the 
directory where you want to install OpenLAB Data Analysis.

e To run an installation qualification as part of this installation, select Run 
Installation Qualification. The Installation Qualification (IQ) provides 
documentary evidence that your system has been built and installed 
correctly. You can run the IQ at a later time if you prefer.

f Click Next to proceed to the Installation Type screen.

g Under Data Analysis Installation Type, choose Networked Workstation.

h Click Next.

i At the OpenLAB Shared Services Settings for Registration screen, type the 
server name in the field provided.

j Click Test Connection... to run a connectivity check. The system will verify 
that the connection from this machine to the Shared Services server is 
functioning.

The system will display a Connection succeeded message if the check is 
successful. Click OK to close the message.

k Click Next to proceed to the Summary screen.
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11 Click Start to begin installation.

12 When the installation is finished, click Next to proceed to the Installed 
Features screen.

13 Click Finish to close the installation wizard.
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What to do Next

The basic installation of the data system software is complete.

There is a 60-day Startup License for this system, and the expiration period 
starts with your first launch of an application.

To request and download your final software license, and add the license file 
to your system, see the Software License Installation Guide.

After you have acquired and installed your final software license, you will 
continue to prepare your data system for operation by end users by 
configuring projects, users, and instruments. This is accomplished through the 
OpenLAB CDS Control Panel, which features an online help resource. For 
more information, please contact your Agilent representative.
42 CDS Networked Workstation Installation Guide



CDS Networked Workstation Installation Guide
4
Uninstall the Software

About Uninstallation 44

Run the Master Installer 45

Run the OpenLAB CDS Uninstallation Wizard on a CDS Client 46

Run the OpenLAB CDS Uninstallation Wizard on the OpenLAB Shared 
Services Server 47

This chapter contains information on the uninstallation by using the OpenLAB 
CDS Uninstallation Wizard.
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About Uninstallation

Like the installation, the uninstallation of OpenLAB CDS is automated by the 
OpenLAB CDS Master Installer. 

For your convenience, Master Installer uses the same user interfaces for the 
software uninstallation of all OpenLAB CDS configurations (standalone or 
networked workstation). The OpenLAB CDS Uninstallation Wizard under the 
Maintenance section of the Master Installer guides you through the 
uninstallation steps.

For uninstalling OpenLAB CDS, you need to have administrator privileges for 
all servers and clients. Power user privileges are not sufficient (the 
uninstallation does not start).
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Run the Master Installer

To run the Master Installer on your workstation choose one of the following 
approaches:

• To run the uninstallation from disk, insert the OpenLAB CDS Installation 
disk (Disk 1).

Autostart will automatically run Agilent.OpenLABCDSSetupFromDVD.exe 
and display the installer Planning screen.

• For the portable data storage device  approach, insert the device in a 
computer USB port, navigate to \Disk1 and run Setup.bat to proceed to the 
Planning screen.

• For the share file  approach, copy the contents to the local drive and 
navigate to the respective share file folder. Then navigate to \Disk1 and run 
Setup.bat to proceed to the Planning screen.
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Run the OpenLAB CDS Uninstallation Wizard on a CDS Client

1 From the Master Installer Planning screen, select Maintenance from the side 
bar menu.

2 Select OpenLAB CDS Uninstallation.

The OpenLAB CDS Uninstallation Wizard opens.

3 In the Shared Components screen: 

a Check the Uninstall Installation Qualification check box.

b If you want to remove IO Libraries as well, select the Uninstall IO Library 
check box.

4 Select Next to proceed to the Summary screen.

5 In the Summary screen under Uninstallation of OpenLAB CDS Components, there 
is a list of the components you want to uninstall.

6 Select Start to start the uninstallation.

7 If you want to abort the uninstallation, select Cancel. If you want to change 
any settings, select Back.

All listed components are automatically uninstalled, one after another.

When a component is uninstalled correctly, the status shown in the Status 
field of the Maintenance screen changes from Installed to Uninstalled 
successfully.

When the uninstallation has finished, click Finish to close the Uninstallation 
Wizard.

NOTE IQ needs to be uninstalled if you want to reinstall OpenLAB CDS at a later time.
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Run the OpenLAB CDS Uninstallation Wizard on the OpenLAB 
Shared Services Server

1 From the Master Installer Planning screen, select Maintenance from the side 
bar menu.

2 Select OpenLAB CDS Uninstallation.

The OpenLAB CDS Uninstallation Wizard opens.

3 In the Shared Components screen, check Uninstall Installation Qualification and 
Uninstall MS SQL Server 2008 R2.

Under SQL Instance, select the instance you want to uninstall from the 
drop-down list.

4 Select Next to proceed to the Summary screen.

5 In the Summary screen under Uninstallation of OpenLAB CDS Components, there 
is a list of the components you want to uninstall.

6 Select Start to start the uninstallation.

7 If you want to abort the uninstallation, select Cancel. If you want to change 
any settings, select Back.

All listed components are automatically uninstalled, one after another.

When a component is uninstalled correctly, the status shown in the Status 
field of the Maintenance screen changes from Installed to Uninstalled 
successfully.

When the uninstallation has finished, click Finish to close the Uninstallation 
Wizard.

NOTE IQ needs to be uninstalled if you want to reinstall OpenLAB CDS at a later time.
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This chapter describes the syntax and parameters for an installation or 
uninstallation in command line mode.
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About Scripted Installation
About Scripted Installation

The OpenLAB CDS Master Installer supports a command line mode for 
installation, the so-called scripted installation. This mode supports 
installation, upgrade, repair, and uninstallation. You can execute scripted 
installations either manually or as part of software management systems such 
as LANDesk or HP CM. With the corresponding parameter (-q), the scripted 
installation is completely UI-less.
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Export as XML 

The Master Installer supports a feature to export the installation parameters 
into an XML file which you can then use for the scripted installation.

This feature is also supported for upgrade and repair. However, for these cases 
the exported installation XML file is not appropriate. For scripted repair and 
upgrade, you must prepare specific XML files using the respective Master 
Installer wizards.

1 Launch the OpenLab CDS Installation Wizard.

2 Follow the instructions as described under Install the Software in this 
manual.

3 When you have reached the Summary screen, click the icon  on the top 
right corner to export the installation parameters to XML. Save the file on a 
physical drive.

You can now use the XML file for the scripted installation.

NOTE Installation file and XML file must not be in the same file path.
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Parameters

You can call Agilent.OpenLAB.CDSInstaller.exe in command line mode with the 
following parameters:

• -i

Installation, upgrade or repair

• -u

Uninstallation

• ConfigurationXML="<ConfigurationXMLFilePath>"

The XML file contains all required inputs of the Master Installer to install, 
upgrade, or repair a certain topology (see “Export as XML” on page 51). 
Replace <ConfigurationXMLFilePath> with the correct file path and XML 
file name.

• KeepComponents

Optional parameter for the uninstallation process, which can contain one 
or more shared components that should stay on your system. Without this 
parameter, all OpenLAB CDS components will be removed from your 
system. To keep certain shared components, list the corresponding IDs 
from the table below in double quotes and separated by comma.

• -q

Silent mode — no installation or uninstallation wizard will be shown.

NOTE Do not enter a blank before or after the equals (=) sign. The scripted installation and 
uninstallation mode will not work as expected.

Component Name Id

Installation Qualification IQT

Microsoft SQL Server SQLServer

IO Library IOLibraries
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After installation in the command line mode, the system will return a number 
code which is explained below.

Table 2 Return codes for installation, upgrade, or repair

Error/Return Code Return value

Unknown (default) -1

Success 0

CoreComponentFailure 1

NonCoreComponentFailure 2

TestConnectivityFailure 3

ExpectedWindowsInstallerNotInstalled (WI 4.5 missing) 4

ParameterMismatchError 5

CannotProceedWithFreshInstallation 6

CannotProceedWithUpgrade 7

CannotProceedWithRepair 9

CannotProceedWithReRegistration 10

ReRegistrationNotSupported 11

IncompleteTopologyFound 12

InvalidUNCPath 13

MissingInstallable 14

NotAStrongPassword 15

DowngradeNotSupported 16

RestartRequired 17

InvalidInputXML 19

InvalidMode 20

SitePrepFailure 21
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Table 3 Return codes for uninstallation

Error/Return Code Return value

Unknown (default) -1

Success 0

CannotProceedWithUninstallation 8

RegistryCleanupError 18
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In installation mode, the OpenLAB CDS Master Installer checks if .Net 
Framework is present on your system. If not, it will automatically be installed. 
Select Accept to agree with the license agreement.

The Master Installer evaluates the products already installed on your system. 
Depending on the installed components, the Master Installer will offer one of 
the following options:

• Start a fresh installation

• Upgrade

• Repair

If a required installable is missing, the Master Installer will create an entry in 
a log file, and, depending on the component type, will continue or rollback the 
installation. A corresponding error code will be returned in such scenarios.

1 Right-click the executable of the command prompt or Power shell prompt, 
and run it as administrator.

You will get a return code for the scripted installation only if you start it as 
administrator.

2 Navigate to the drive where you have saved the disks.

For example: C:\CDS_DVD

3 To start the installation, call Agilent.OpenLab.CDSInstaller.exe with the 
following syntax: 

Agilent.OpenLab.CDSInstaller.exe -i ConfigurationXML="<path to xml 
file>" -q

For example:

Agilent.OpenLab.CDSInstaller.exe -i ConfigurationXML="c:\settings\
ConfigurationXML.xml" -q

With this command, you start the installation wizard without a user 
interface.

Preparations You must have copied all disks to a centralized folder (see “Step 2: Copy DVDs to a Centralized 
Folder for Installation (Optional)” on page 19). This step is mandatory for scripted installation.
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5 Scripted Installation
Uninstallation
Uninstallation

1 Right-click the executable of the command prompt or Power shell prompt, 
and run it as administrator.

You will get a return code for the scripted uninstallation only if you start it 
as administrator.

2 Navigate to the drive where you have saved the disks.

For example: C:\CDS_DVD

3 To start the uninstallation, call Agilent.OpenLab.CDSInstaller.exe with the 
following syntax:

Agilent.OpenLab.CDSInstaller.exe -u KeepComponents="<list of 
components>" -q

For Example:

Agilent.OpenLab.CDSInstaller.exe -u KeepComponents="IQT,IOLibraries" -q 

With the KeepComponents parameter, you can specify a list of shared 
components that you want to keep on the system (see “Parameters” on 
page 52). With the command given in the example, the OpenLAB CDS 
components Installation Qualification (IQT) and IO Library (IOLibraries) 
will be kept.
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Scripted Installation 5
Logging and Tracing
Logging and Tracing

All exceptions, errors and information messages are logged in the following 
locations:

• During installation, upgrade, or repair: under <BaseInstallDirectory>\Logs

• During uninstallation: under <User's Temp>\<Company Name>\Logs\<Log 
folder>\<Wizard Name>.txt
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5 Scripted Installation
Logging and Tracing
58 CDS Networked Workstation Installation Guide



CDS Networked Workstation Installation Guide
6
Optional Procedures

Run the IQ After Software Installation 60

Configure Advanced File Security (AFS) 61

Enable Advanced File Security 61

This chapter includes information on how to use the Installation Qualification 
Tool and how to configure the Advanced File Security (AFS). 
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6 Optional Procedures
Run the IQ After Software Installation
Run the IQ After Software Installation

The installation qualification (IQ) provides documentary evidence that your 
system has been built and installed correctly, and that all design specifications 
have been met.

1 Using your Windows operating system, go to Start > All Programs > Agilent 
Technologies > Installation Qualification Tool.

2 Select Qualify.

The system will run the application and generate an Installation 
Qualification Report.

3 If the report indicates failure, verify the computer requirements and 
reinstall the data system.

Do not use the system until an Installation Qualification Report gives a 
‘pass’ result.
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Optional Procedures 6
Configure Advanced File Security (AFS)
Configure Advanced File Security (AFS)

Advanced file security is an optional configuration for OpenLAB CDS 
EZChrom Edition networked systems. It provides enhanced security on the 
enterprise path in order to prevent any unauthorized access to project data 
outside of the data system. This configuration sets the appropriate Windows 
sharing and security settings to allow only a defined group to access the 
enterprise data from Windows Explorer. This may only be configured if your 
system is configured to use Windows Domain as the Shared Services 
authentication provider.

Enable Advanced File Security

1 Prepare your system.

a Verify that your system is configured to use Windows Domain as the 
authentication provider. (See Configure Security and Storage > Set the 
authentication provider and the storage system in the online help.)

b Verify that your system is configured to use a storage path that is directly 
beneath the defined enterprise path.

c Create or define a Windows Domain group that will have access to the 
enterprise path outside of the data system.

d Define a minimum of two users who are members of the group defined 
above.

e Close all connections to the OpenLAB CDS system (i.e. clients, 
instrument runs, control panels).

f Obtain the login credentials of a domain user that has administrative 
rights to edit the enterprise path in its current state.

g Obtain the administrative login credentials of the OpenLAB Control 
Panel that were defined during the configuration of domain 
authentication.

NOTE Advanced File Security is not supported when using OpenLAB Data Analysis.
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6 Optional Procedures
Configure Advanced File Security (AFS)
2 On any OpenLAB CDS EZChrom Edition client, browse to the directory 
where the software was installed.

(by default: C:\Program Files\Agilent Technologies\EZChrom)

3 Launch EnterpriseConfig.exe.

4 An Enterprise Setup Login dialog will display:

a In the OpenLAB Control Panel Login section enter the user name, password, 
and domain of the OpenLAB Control Panel Administrator.

b In the Windows User Information section enter the user name and password 
of the user with edit permission to the enterprise path.

• If this is a domain user account, select Logon from Windows Domain and 
enter the domain name (recommended).

• If this is a local PC account, select Windows Local PC. This may only be 
an account local to the machine where the EnterpriseConfig.exe program 
is being run.

c Click OK.

5 The system will process the above credentials. If they are valid, a warning 
will display to advise that once this process is completed, it cannot be 
reversed.

Click OK if you are prepared to proceed.

6 An Enterprise Service Account dialog will display:

a Enter the user name, password, and domain of a user defined to be a 
member of the AFS group.

b Enter the group name that will have access to the enterprise path under 
the restrictions of AFS.

c Click OK.
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Upgrade to New Software Version

Upgrade from Different Revisions 64

Step 1: Upgrade the OpenLAB Shared Services Server 65

Step 2: Upgrade a Networked Workstation 66

This chapter describes the upgrade procedures for an OpenLAB Shared 
Services server and for Networked Workstations.
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7 Upgrade to New Software Version
Upgrade from Different Revisions
Upgrade from Different Revisions

OpenLAB Shared Services Server and ChemStation machines

If you currently have a revision older than A.01.04 installed on the OpenLAB 
Shared Services server or on a ChemStation machine, the OpenLAB CDS Upgrade 
Wizard will upgrade the existing installation. You need to first upgrade the 
OpenLAB Shared Services server before upgrading the connected networked 
workstations.

EZChrom machines

On EZChrom machines, OpenLAB CDS A.01.01 needs to be uninstalled before 
installing A.01.04. Upgrading from A.01.02 or higher does not require an 
uninstallation.
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Upgrade to New Software Version 7
Step 1: Upgrade the OpenLAB Shared Services Server
Step 1: Upgrade the OpenLAB Shared Services Server

To upgrade the OpenLAB Shared Services server to A.01.04, perform the 
following steps:

1 From the Master Installer Planning screen, switch to the Installation screen.

2 Select OpenLAB CDS Installation. As OpenLAB CDS is already installed, this 
automatically opens the OpenLAB CDS Upgrade Wizard.

3 In the Upgrade Type screen, select Next to proceed to the Summary screen.

4 In the Summary screen of the Upgrade Wizard, the components for the 
upgrade are listed. Select Start to start the upgrade.

If an error occurs during the upgrade, an error message appears. When a 
component is upgraded correctly, the status shown in the Status field 
changes from Installed to Successfully Upgraded.

5 After the upgrade is completed, a warning message appears, stating that 
you must restart Windows for some changes to take effect.

Select Yes to restart Windows.

Select No if you want to restart Windows at a later time.
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7 Upgrade to New Software Version
Step 2: Upgrade a Networked Workstation
Step 2: Upgrade a Networked Workstation

To upgrade a Networked Workstation to OpenLAB CDSA.01.04, perform the 
following steps:

1 From the Master Installer Planning screen, switch to the Installation screen.

2 Select OpenLAB CDS Installation. As OpenLAB CDS is already installed, this 
automatically opens the OpenLAB CDS Upgrade Wizard.

3 In the Upgrade Type screen, select Next to proceed to the Summary screen.

4 In the Summary screen of the Upgrade Wizard, the components for the 
upgrade are listed. Select Start to start the upgrade.

If an error occurs during the upgrade, an error message appears. When a 
component is upgraded correctly, the status shown in the Status field 
changes from Installed to Successfully Upgraded.

5 After the upgrade is completed, a warning message appears, stating that 
you must restart Windows for some changes to take effect.

Select Yes to restart Windows.

Select No if you want to restart Windows at a later time.
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Appendix

Change Server Authentication to Mixed Mode 68

This chapter contains additional information on Microsoft SQL Server 2008 R2.
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8 Appendix
Change Server Authentication to Mixed Mode
Change Server Authentication to Mixed Mode

This procedure desribes how you can switch to Mixed Mode in an existing 
Microsoft SQL Server 2008 R2 installation.

1 Start SQL Server Management Studio.

2 In the Object Explorer, right-click the server name, and select Properties 
from the context menu.

3 In the Server Properties dialog, select the Security page.

4 Under Server authentication, select SQL Server and Windows Authentication mode.

5 Click OK.

6 Enable login for user sa.

a In the Object Explorer, navigate to Security > Logins.

b Right-click the user sa, and select Properties from the context menu.

c In the Login Properties dialog, select the General page.

d Provide a strong password.

e Select the Status page.

f Under Login, select Enabled.

Click OK.

7 Restart the SQL Server service, and log in with SQL Server Authentication.
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